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1. d.velop documents in HCL Notes

1.1. Basic information on the application and the manual
This documentation describes the installation, configuration and update of d.velop documents integra-
tion in HCL Notes and is intended for administrators.

It will help your understanding if you have knowledge of Microsoft Windows and HCL Notes. You can
find more information about operating d.velop documents in HCL Notes in the quick guide for the
d.velop documents e-mail integrations.

The sample repositories and archives used are based on the Microsoft Demonstration Platform and the
fictional company Contoso.

1.1.1. About d.velop documents
d.3one is an innovative modern product suite with the philosophy of focusing on the end users and
supporting them from wherever they would like to access ECM information, be it Microsoft Outlook,
Microsoft Office, HCL Notes, or simply the browser.

Seamless integration and simple handling

You can define a few areas for your users so that they can access the required information with a URL,
without detours and without many clicks.

The innovative search supports you step by step in finding information and data using the facets. In this
way, you also quickly gain an overview when you have large quantities of data. Importing documents into
dossiers is accomplished quickly with drag & drop, whether it is one document or several.

An intelligent check for duplicates protects you from importing identical data multiple times. You can
change document contents and properties at any time. You can also edit contents of Microsoft Office
documents natively and straightforwardly in Microsoft Office.

As a team and across the organization, you communicate directly in d.3one using Tasks and Messages as
well as with integrate forms, so that everyone can participate in digital business processes.

Expandability and adaptation

You can expand and adapt d.3one individually with functions, tailored to your requirements.

d.3one is an innovative tool that allows you to collaborate with the d.3ecm world.

1.1.2. Architecture of a d.3ecm system environment
We in d.velop AG focus on a modern software architecture based on microservices among other things.

For example, d.3one is a collection of single microservices that interact and provide the user with DMS
functionality in the user interface. Each microservice is a standalone application.

In the d.3ecm architecture, a microservice is referred to as an app.

Each d.velop product consists of its own apps which are specific for the product and which are installed
using a product-specific setup. If, for example, an app was installed several times as separate app
instances (e.g. for cluster operations or scaling purposes), all apps must have the same version.

Based on this architecture, you can decide freely according to the requirements of your server environ-
ment, which app should be install on which host how many times in the d.3ecm environment. This
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architecture design offers you maximum freedom to cover your specific requirements for the IT environ-
ment.

Besides the product-specific apps, there are the core apps that you need to consider separately.

Core apps in the d.3ecm architecture 

There are a number of apps that are of crucial importance for many d.velop AG products in the d.3ecm
system landscape. All the apps below are installed as infrastructure products using d.velop software
manager and are not part of other d.velop products:

d.ecs http gateway 

The d.ecs http gateway app is the core HTTP interface to all app in a d.3ecm environment. Any HTTP
communication is done using this app. From a technical point of view, this is a reverse proxy. Each app
is registered in the d.ecs http gateway app. The newly registered app can then be accessed by all the
other apps under https://<BaseUri>/<AppName>. If you have to run several d.ecs http gateway apps in a
d.3ecm environment, all d.ecs http gateway apps must be accessed under the identical base address. For
each d.3ecm environment, there must be only a single base address.

d.ecs jstore 

The d.ecs jstore app is a NoSQL database that caches frequently requested data from the d.3 server in
the memory of the application server; such data includes, for instance, property values for frequently
used documents. Thus the requested database accesses on the d.3 database are reduced and therefore
the performance of the whole system is increased.

In addition, d.ecs jstore is used by the different d.velop components (e.g. d.3one, d.ecs monitor) to store
data permanently.

d.ecs jstore is based on Redis (Remote Dictionary Server) and replaces Couchbase as cache storage,
which was used until d.3ecm Version 8.0. Among other things, the app is easier to configure and, thus
provides considerable advantages compared to the latest solution.

The d.ecs jstore app is installed on each Windows host on which a d.velop app is run.

In a d.3ecm environment, each single d.ecs jstore instance on a Windows host must be clustered in order
to allow data communication.

d.ecs identity provider 

The d.ecs identity provider app authenticates the users on behalf of each app. You can use systems like
the Windows Active Directory service for authentication. The authorization of a user is done by each
app.

d.ecs shell 

The d.ecs shell app provides the common frame for the HTML interface of each app and implements a
uniform look & feel user experience so that the interface of the apps is consistent and appears to be
made in one piece. The app also provides access to the native functions of the host. In this context a
host may be, for example, an e-mail application, an ERP application or even a browser.

Potential scenarios for a d.3ecm environment with d.3one 

You can design your d.3ecm environment especially according to the requirements of your enterprise or
organization. You can either use one single core application server at minimum or distribute the apps on
different application servers. You can choose how to organize your d.3ecm environment based on your
needs and requirements for your IT environment.

Example 1 

d.velop documents in HCL Notes

5



The core apps were installed on a single application server, while the product-specific apps are installed
on a different application server.

Example 2 

The core apps are distributed on two application servers and the d.ecs http gateway app exists two times
in the d.3ecm environment.

If there are questions regarding the cluster operation or scaling, contact your d.velop representative.

1.1.3. Useful things to know about d.velop documents licenses
With d.velop documents as their integrating application, users can easily use d.3 functions in other
applications, such as:
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• Browsers
• Microsoft Outlook
• Microsoft Office
• HCL Notes
• SAP ERP
• Customer-specific integrations

Each integration must be licensed for each user. The number of users of individual products can vary
within a d.velop documents installation; for instance, 200 users can use d.velop documents in the
browser, but only 50 users can use d.velop documents in Microsoft Outlook. In contrast to a d.3ecm
system environment, d.velop documents is a separate integration application.

When a user uses d.velop documents in the browser or as an integration, license information is retrieved
from the d.3 repository. With each access, each d.velop documents user is allocated a user license in the
d.3ecm system environment. Make sure that enough basic licenses are available for all users that use the
d.3ecm system environment directly or indirectly. We recommend using named user licenses as standard.

Note
Before you install d.velop documents or the integrations, make sure that enough d.3
client access licenses (d.3 CALs) are available. We recommend using a consistent named
user license model in which sufficient d.3 client access licenses are available for every
d.velop documents user.

The functions available to you for the e-mail integrations vary based on the product purchased.

If you have any additional questions about d.velop documents licensing, contact your d.velop contact
person.

See also: Detailed information about named-user licenses

1.1.4. Useful things to know about the license-dependent scope of functions of
d.velop documents in HCL Notes
The scope of functions of the integrations are based on the licenses purchased. You can use the list
below to track which functions are available to you with the various licenses.

No license

• Restoring an item from a d.3 repository
• Offline Store

Basic license

• Restoring an item from a d.3 repository
• Offline Store
• Storing e-mails and attachments using the context menu
• Searching in the d.3 repository

Full license

• Restoring an item from a d.3 repository
• Offline Store
• Storing e-mails and attachments using the context menu
• Searching in the d.3 repository
• Storing items in dossiers using drag & drop
• Sending and simultaneously storing items in a d.3 repository with the Send and store function
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• Opening e-mail content in different applications using the Go to function
• Tasks and messages
• Context-sensitive search using the Search for function
• Using the d.velop documents functions
• Opening d3l reference files
• Sending an item by e-mail as an original file or PDF file
• Creating a new version of a document with alteration text
• Updating document properties
• Displaying documents during editing
• Displaying the properties of an archived e-mail
• Exporting the properties of multiple items
• Exporting documents as PDF files

See also: Assigning full licenses

1.1.5. Useful things to know about storing and displaying e-mails in d.velop docu-
ments
Viewing, displaying and restoring e-mails and different file formats between applications usually involves
visual "losses" and possibly even lost information. To prevent display problems or the potential loss of
information caused by switching applications (e.g. from the e-mail application to the d.3ecm system
environment), the standards and standardized policies of d.velop AG are applied.

The processing that occurs while saving e-mails in HCL Notes or Microsoft Outlook is to a great extent
provider-independent, because the e-mails are stored in a standardized XML format in the d.3 repository.
Thanks to the XML format, information from e-mails and provider-specific information is available at all
times, which means that the information can be restored in HCL Notes or Microsoft Outlook at any time.
However, if the provider redesigns the proprietary templates or forms (e.g. Memo) for e-mails, an e-mail
may be displayed differently after the restore than it was when it was stored in the d.3 repository.

When processing e-mails, the IETF specifications, which have been defined in the Requests for Com-
ments in RFC 2045, RFC 2046, RFC 2047, RFC 2048 and RFC 2049 and are a continuation of RFC 822,
are used by default.

Since RFC 2048 has been classified by the Internet Engineering Task Force (IETF) as Best Practice, RFC
2048 is the applicable policy for the processing of e-mails. In particular, RFC 2048 is the best method for
displaying e-mails that are not displayed with HCL Notes or Microsoft Outlook (e.g. the result list in the
d.velop documents integration for HCL Notes).

The display of e-mails or converted documents in another long-term format (e.g. PDF or TIFF) may differ
visually from the display in HCL Notes or Microsoft Outlook. In terms of content, all the information is
displayed as per RFC 822 and RFC 2048.

You can find more information about this topic on the IETF website, for example.

You can use the list below to track which types of e-mails are processed by d.velop documents and how
the e-mails are stored.

Plain text

• Microsoft Exchange: processed without restrictions.
• HCL Domino: processed without restrictions.

HTML

• Microsoft Exchange: processed without restrictions.
• HCL Domino: processed without restrictions.
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MIME

• Microsoft Exchange: processed without restrictions.
• HCL Domino: processed without restrictions.

S/MIME-based encryption (internal)

• Microsoft Exchange: processed without restrictions.
• HCL Domino: processed without restrictions.

S/MIME-based encryption (external)

• Microsoft Exchange: processed without restrictions.
• HCL Domino: processed without restrictions.

PGP-based encryption (internal)

• Microsoft Exchange: processed without restrictions.
• HCL Domino: processed without restrictions.

PGP-based encryption (external)

• Microsoft Exchange: processed without restrictions.
• HCL Domino: processed without restrictions.

S/MIME-based signature (internal)

• Microsoft Exchange: processed without restrictions.
• HCL Domino: processed with restrictions.
• Comment: e-mails stored with HCL Notes integration require more storage space in the repository

store than the original file.

S/MIME-based signature (external)

• Microsoft Exchange: processed without restrictions.
• HCL Domino: processed with restrictions.
• Comment: e-mails stored with HCL Notes integration require more storage space in the repository

store than the original file.

HCL Notes-based signature (internal)

• Microsoft Exchange: cannot be processed. Storing is denied or not possible.
• HCL Domino: processed without restrictions.
• Comment: restoring can only be done in HCL Domino. Display in the d.3ecm system environment is

possible only with conditions. The saved file is larger than the original file.

HCL Notes-based signature (external)

• Microsoft Exchange: cannot be processed. Storing is denied or not possible.
• HCL Domino: processed without restrictions.
• Comment: restoring can only be done in HCL Domino. Display in the d.3ecm system environment is

possible only with conditions. The saved file is larger than the original file.

If e-mails are encrypted and signed, it is sometimes only possible to show that the e-mails are encrypted,
because the signature is also encrypted.

Although you can decrypt an e-mail that is to be saved, the e-mail is stored encrypted in the d.3
repository.

d.velop documents in HCL Notes
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You cannot store attachments from encrypted e-mails. However, you can store the whole e-mail.

1.2. Installation and uninstallation
This section provides you with information about installing, updating and uninstalling d.velop documents
in HCL Notes and the components required.

1.2.1. System requirements
This section provides you with information about the system requirements for installing d.velop docu-
ments in HCL Notes on the server and on client PCs. You can find all the general system requirements for
d.velop documents in the d.3one administration manual.

The following minimum requirements apply for the integration:

Supported operating systems

• Microsoft Windows 10
• Microsoft Windows 11
• Microsoft Windows 8.1
• Windows Server 2012
• Windows Server 2012 R2
• Windows Server 2016
• Windows Server 2019
• Windows Server 2022

Supported applications and services (d.velop documents domino)

• HCL Domino: version 10
• HCL Domino: version 11
• HCL Domino: version 12
• HCL Notes: version 10
• HCL Notes: version 11
• HCL Notes: version 12

Supported applications and services (server)

• d.ecs rendition service: To enable your users to perform a full-text search for an HCL Notes e-mail
stored in a d.3 repository, you need to install d.ecs rendition service and configure it for the DGIX
format.

• ABBYY FineReader (optional): To enable your users to perform a full-text search for e-mail attach-
ments, e.g. for an image file with additional textual information, you need to use the ABBYY FineRead-
er OCR text recognition software in addition to d.ecs rendition service. For more information about
d.ecs rendition service and supported ABBYY FineReader versions, see the d.ecs rendition service
administration manual.

Supported operating systems (client PCs)

• Neither Unix-based platforms nor mobile operating systems are supported.
• If you want to use the integration or dependent modules (e.g. d.velop documents domino) in virtual

environments, please ask the third-party manufacturers of the applications required to operate d.velop
documents about the requirements and settings for operation in virtual environments.

Supported applications and services (client PCs)

• HCL Notes: Version 10.0, 11.0 and 12.0

Applications needed
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• d.velop documents version Current 2022
• d.velop infrastructure components, version 1.3.0 or later. The authentication method is provided by

d.ecs identity provider. You must configure LDAP support for each d.3 repository; otherwise, logging
in is not possible. Enter the provider LDAP in d.ecs identity provider. You can find more information in
the d.3 admin LDAP and d.ecs identity provider administration manuals.

• .NET Framework 4.7.1

Notes for correct display of the integration

• The screen must have a 16-bit color depth at minimum.

Notes on pop-up blockers

If you are using a restrictive pop-up blocker, workflows from the integration may not open correctly. We
recommend configuring the pop-up blocker so that pop-ups are permitted for the d.velop documents
application server and d.3 presentation server.

1.2.2. Preparing the installation).
In this topic, you can find information about all the tasks involved in preparing for the installation. You
can then begin with the installation.

When you install d.velop documents in HCL Notes, you receive all the necessary components with the
d.velop documents setup program.

Note
If you are using HCL Domino server version 11.0.1 or 12.0, make sure that d.velop
documents domino is running as an application and not as a service.

The d.velop documents domino service is provided as a standalone setup program during the setup
process, enabling you to install the d.velop documents domino service on the HCL Domino server. You
cannot proceed with the setup until you have installed the d.velop documents domino service on the
HCL Domino server.

For both setups, you have to specify the name of the d.velop documents application server that you are
installing with the setup. The host name of the d.velop documents application server is the base address
of d.velop documents.

1.2.3. Installing d.velop documents in HCL Notes
You install the software exclusively with d.velop software manager. If an application is required for
different products, the corresponding software packages are also installed automatically.

For further information on installing the software, see the d.velop software manager manual.

1.2.4. Installing the DGIX viewer to display e-mails
In the integration, data and information from the e-mail application are stored in a special format for
long-term archiving. A DGIX file is a type of ZIP file that contains an XML file with the useful data and a
folder for any available file attachments.

You require a special view to display files in DGIX format. There are two variants for the viewer:
DGI2EML and DGI2HTML. You can use these tools to display DGIX files in the e-mail application.

A setup program for installing the DGIX viewer is provided in the d.velop documents setup program.
There are two ways to install the DGIX viewer on all your client PCs:

• Installing the DGIX viewer locally
• Installing the DGIX viewer using Active Directory software distribution

d.velop documents in HCL Notes
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See also:

• Detailed information about how DGI2EML works
• Defining call parameters for DGI2EML
• Detailed information about how DGI2HTML works
• Defining call parameters for DGI2HTML

1.2.5. Installing the DGIX viewer locally
You can install the MSI package for DGIX Viewer using d.velop software manager. By default, the setup
file is located in the folders <installation path>\dgi2eml and <installation path>\dgi2html. The steps
for installing the DGIX viewers DGI2HTML and DGI2EML are the same. Since both DGIX viewers are
registered for the file extension *.dgix, the most recent DGIX viewer installed always opens. Choose one
of the two viewers.

To ensure that your users can locally install the setup for the DGIX viewer on the client PCs, the
following requirements must be fulfilled:

• The client PC users must be logged in as administrators.
• The system requirements for the client PC must be fulfilled.

The setup wizard guides you through the installation step by step. Check each step and choose the
appropriate options for your requirements.

You can use the DGIX viewer immediately following the installation.

You can also install the MSI packages without a user interface. If you want to change the installation
path, add the parameter APPLICATIONFOLDER to the target directory. Otherwise, the default path is
used.

Example: DGI2HTMLSetup_1.8.0.0.msi APPLICATIONFOLDER="C:\<Installation directory>" /q

1.2.6. Installing the DGIX viewer using Active Directory software distribution
Once you complete the installation in d.velop software manager, the setup files for installing the DGIX
viewer locally are created automatically. The default location for the setup files is in the folders <in-
stallation path>\dgi2eml and <installation path>\dgi2html. The steps for installing the DGIX viewers
DGI2HTML and DGI2EML are the same. Since both DGIX viewers are registered for the file extension
*.dgix, the most recent DGIX viewer installed always opens. Choose one of the two viewers.

Let’s assume you want to install the DGIX viewer using AD software distribution.

This is how it works

1. Create a new folder in the domain controller (e.g. <installation path>\Software distribution.
2. Copy the setup file for the DGIX viewer and add the file to the new folder.
3. Share the folder.
4. Grant read access to the folder to every user.

You then have to create a security group with a group policy and create the new MSI package with the
DGIX viewer setup.

Creating a group policy for AD software distribution for the DGIX viewer
If you have created a security group for the MSI package setup, you must define a group policy for the
group in the domain controller.

This is how it works

1. Open Control Panel > Administrative Tools > Group Policy Management.

d.velop documents in HCL Notes
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2. Select the domain.
3. Select Action > Create a GPO in this domain, and link it here.
4. Enter a name for the group policy.
5. Select the created policy.
6. Enter the created group under Security Filtering and save your entries.

You then have to create the new MSI package with the DGIX viewer setup.

Creating a security group for AD software distribution for the DGIX viewer
To distribute the MSI package software, you must create a new security group containing the users for
Active Directory software distribution.

This is how it works

1. Open Control Panel > Administrative Tools > Active Directory Users and Computers.
2. Select the domain.
3. Choose Action > New > Group to create a new group.
4. Enter a name for the security group under Group name.
5. Under Group scope, select the option Global.
6. Under Group type, select the option Security. Save your entries.

You then have to create a group policy and the new MSI package with the DGIX viewer setup.

Creating a software package for AD software distribution for the DGIX viewer
If you have created a security group and a group policy for a group of users, you must create a new
software package for the MSI package setup in the Group Policy Management Editor.

This is how it works

1. Select the created group policy in Group Policy Management.
2. Click Action > Edit to open the Group Policy Management Editor.
3. Click User configuration > Policies > Software Settings > Software Installation to select the soft-

ware installation.
4. Click Action > New > Package to add the setup. It must be possible to reference all the packages as

UNC paths.
5. Select the package and open the package properties.
6. Go to the Software Deployment tab.
7. Under Deployment type, select the option Assigned.
8. Under Deployment options, select the options Uninstall this application when it falls out of the

scope of management and Install this application at logon.
9. Under Installation user interface options, select Basic.
10. Log into the client PC again.

If you have installed the DGIX viewer using AD software distribution, you can find the DGIX viewer in
the Control Panel under Programs and Features after restarting.

If the entry is not displayed, enter the command gpupdate /force in the command prompt. Then restart
the client PCs.

1.2.7. Installing d.velop documents domino
Before you can configure the Groupware app, you have to install d.velop documents domino on the HCL
Domino server. Run the d.velop documents domino setup program on the HCL Domino server to install
d.velop documents domino (servlet) and the d.velop documents update site.

You can specify the installation path of the d.velop documents domino service when you select the
components in the setup. The default installation path is: d3\d.3one\addons\DecsDomino

d.velop documents in HCL Notes
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Let's assume you have completed all the preparatory steps and want to install d.velop documents
domino.

This is how it works

1. In the Groupware app setup, select the d.ecs domino service setup component.
2. Open the folder d3\d.3one\addons\DecsDomino in the installation directory and copy the file

decs_domino_windows_<version number>_setup from the folder.
3. Go to the HCL Domino server and paste the d.velop documents domino setup program into a

directory.
4. Run the EXE file as an administrator and follow the installation steps in the installation wizard.
5. Enter the installation location.
6. Select which components you want to install.
7. Under IBM Domino server, enter the name and domain of the HCL Domino server on which the

d.velop documents domino service will be installed.
8. Under IBM Domino administrator, enter the login name of the HCL Domino administrator account

and the domain. Make sure that the user has permissions to create databases and start services.
9. Enter the base address under d.3one application server host. This is the name of the server on

which d.velop documents is or will be installed.
10. Under d.3one application server port, enter the default port for d.ecs http gateway. The default

value is 443.
11. Under Path for temporary files, enter a folder where temporary files that are needed when pro-

cessing documents will be stored while d.velop documents domino is running. Make sure that the
temporary folder is not scanned by any antivirus software; otherwise, access to temporarily stored
files may be disrupted.

The next step is to specify the certificate to be used for communication between the d.velop documents
application server and d.velop documents domino.

Specifying the certificate for communication between the d.velop documents ap-
plication server and d.velop documents domino
After you have specified the path for the temporary files during the setup with the installation wizard,
you have to specify the certificate to be used for communication between the d.velop documents appli-
cation server and d.velop documents domino. The further steps in the installation will differ depending
on the option you select, and you will need to enter different information for each option. Three options
are available to you:

• Create self-signed certificate: This certificate is suitable for testing purposes only. You have to man-
ually install the certificate as a valid certificate on the d.velop documents server. Creating a self-signed
certificate creates only the certificate itself. It does not create a trust relationship via a valid certifica-
tion authority.

• Install trusted certificate: This option allows you to use a certificate for d.velop documents domino
that already exists on the server. You may need to distribute the certificate to establish a trust relation-
ship between the server running d.velop documents domino and the d.velop documents application
server.

• Use Keystore from previous installation: If you have already uninstalled d.velop documents domino
on a server but the configuration and Keystore still exist, you can use this option to reuse the original
Keystore.

Creating a self-signed certificate
You can create a self-signed certificate—for testing purposes, for example—by selecting the Create
self-signed certificate option during the d.velop documents domino setup. You can use the Certify and
import the PKCS #7 file option to send a certificate signing request (CSR) to your domain to have the
self-signed certificate certified by a valid certificate authority in your domain. You can use the signed
certificate in a production environment without having to distribute the certificate manually.
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To use the certificate, follow the steps in the installation wizard.

Let's assume you also want to use the self-signed certificate in your production environment.

This is how it works

1. Enter the organization data in the wizard.
2. Enter the password for the Keystore.
3. Check that the host name is identical to the fully qualified domain name (FQDN) you entered in the

d.3one in IBM Notes: d.ecs domino address installation step under d.ecs domino host.
4. Enter one or more organizational units under Organizational Unit. Separate multiple entries with a

semicolon.
5. Under Country, enter the two-character ISO country code, e.g. DE for Germany or US for the

United States of America.
6. Enable the Certify and import the PKCS #7 file option.
7. Define a password for the Keystore to be created.
8. Copy the entire contents of the Certificate request text box.
9. Select the Web server option for the certificate template.
10. Provide the contents of the certificate to your certification authority for signing.
11. Create a Base64-encoded certificate chain as a *.p7b file.
12. Enter the exported certificate chain in the input box.

Installing a trusted certificate
If you have a trusted certificate, you can use the certificate for the d.velop documents domino setup.
During setup, select the option Install trusted certificate.

To use the certificate, follow the steps in the installation wizard. Specify the certificate and enter
the password for the Keystore. This certificate is a different certificate than the d.velop documents
certificate. You need to issue the certificate for the server that is running the HCL Domino server with
the d.velop documents domino service installed.

Alternatively, you can create a domain certificate for d.velop documents domino in the same way you
create a web server certificate for d.ecs http gateway. Enter the fully qualified server domain name
(FQDN) you entered in the d.3one in IBM Notes: d.ecs domino address installation step under d.ecs
domino host.

If your certificate is encrypted, enter the password for the Keystore used by d.velop documents domino
in the d.velop documents domino setup. The Keystore is automatically created with the PKCS12 Key-
store certificate chain and the new password.

Using a Keystore from a previous installation
If you have already uninstalled d.velop documents domino on a server but you did not delete the config-
uration and the Keystore during the uninstall, you can use the Keystore for communication between the
d.velop documents application server and d.velop documents domino.

To use the existing Keystore, follow the steps in the installation wizard. Enter the password and the key
for the Keystore.

Configuring the HCL Domino-based update site with the d.velop documents domi-
no setup (new installation only)
If you select Install d.ecs domino and Install update site when installing d.velop documents domino for
the first time, you can fully configure the HCL Domino-based update site during the setup. During the
setup you can also configure a widget catalog, a policy, a desktop setting and a group for distributing the
d.velop documents sidebar plug-in in the mailbox.
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You can make various settings for the update site and widget catalog in the setup dialog Create an IBM
Notes/Domino UpdateSite and WidgetCatalog.

This is how it works

1. Select Create an IBM Notes/Domino UpdateSite to create an NSF-based update site on the HCL
Domino server.

2. If necessary, select Use named server if you want to set up the update site on an alternate server,
then enter the name of the alternate server under Server name. If you want to use the current HCL
Domino server, leave the option unselected.

3. If necessary, enter the file name of the update site database, including the path relative to the
Domino data directory, under File name. The default file name is: dvelop/d3ecm_updatesite.nsf

4. If necessary, enter the title of the database to be created under Title. The default title is d.3ecm
UpdateSite.

5. Select Create an IBM Notes/Domino WidgetCatalog to create a widget catalog on the HCL Domino
server. The widget catalog is based on toolbox.ntf.

6. If necessary, enter the file name of the widget catalog database, including the path relative to the
Domino data directory, under File name. The default title is d.3ecm WidgetCatalog.

7. If necessary, enter the category of the widget under Category. The default category is d.3ecm.
8. If necessary, specify a protocol under Use NRPC or HTTP for distributing the d.velop documents

sidebar plug-in in the mailbox. NRPC (Notes Remote Procedure Call) is used by default. For the
HTTP option, you have to enable and configure the HTTP task for the HCL Domino server.

Setting the host and port for d.velop documents domino
After you have performed the setup, you need to specify the host computer and the port for d.velop
documents domino in the configuration of the Groupware app.

This is how it works

1. Open the Configuration feature from the start page and select the item IBM Domino under E-mail
management in the Common settings area.

2. Click Enable IBM Domino services.
3. Under d.ecs domino service server, enter the host name of the HCL Domino server as a fully

qualified domain name (FQDN).
4. If necessary, change the port for d.velop documents domino. The HCL Domino server uses the port

to communicate with the d.velop documents application server. The default port is 8182. If you
change the default port, enter the new port in the HCL Domino configuration database under SSL
port. You also have to change the SSL port under d.ecs domino in the d3onecfg.nsf database on the
HCL Domino server.

5. Save your entries.

1.2.8. Distributing d.velop documents in HCL Notes
You can distribute d.velop documents in HCL Notes using the update site on the HCL Domino server.
Multiple options are available to you:

• Install the update site on another server: If you have installed d.velop documents domino, you can find
the d.velop documents update site on the server where HCL Domino is installed. If you want to install
the update site on another server, run the d.velop documents domino setup again on the server of
your choice. Enable only the Install update site option.

• Import the update site into an HCL Notes-based update site: You can also import the update site into
an HCL Notes-based update site (based on the updatesite.ntf template). For more information, see the
documentation for HCL Notes.

• Manually copy the update site to another server: If you manually copied the update site to another
server or canceled the d.velop documents domino setup, you must also manually adjust the references
(URLs) to the update site in the extension.xml file. For more information, see the documentation for
HCL.
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• Move the update site: You can move the update site to another location at any time. You can find
a customized XML file (extension.xml) in the update site root directory. The XML file references the
site.xml file of the local update site. You can import the extension.xml file into your widget catalog
(toolbox.nsf). If you move the extension.xml file, you have to adjust the path to the site.xml file. The
URL must be structured in such a way that the site.xml file is accessible from every client PC on
which d.velop documents is installed. You can find the valid URLs for the updatesite.nsf file in the
corresponding database under Actions > Show URLs. Enter the URL in the extension.xml file under
url=.

Note
According to HCL, file system paths (file URLs) are not supported in the extension.xml
file.

Additionally, make sure that WebView2 Runtime is installed on the application client. You
can install WebView2 Runtime manually or via the Windows MSI domain.

You can also distribute d.velop documents in HCL Notes using group policies. You have the following
options:

• Distribute the plug-in using policies: You can distribute d.velop documents in HCL Notes to specific
users or user groups via policies by adding the plug-in to the toolbox.nsf file. For more information,
see the HCL Domino Administrator Help.

• Distributing d.velop documents using group policies: If you distribute d.velop documents using group
policies in HCL Notes, please note that d.velop AG has provided the plug-in for d.velop documents
with a digital code signature. You must use group policies to distribute the supplied certificate and all
certificates in the certificate chain to users. For more information, see the HCL Domino Administrator
Help.

1.2.9. Distributing certificates to client PCs with HCL Notes
For you and your users to use d.velop documents with HCL Notes, you need to distribute the Internet
certificate used by the d.velop documents application server to the client PCs using HCL Notes. The
certificate is the same one you entered in the Certificate selection step during installation.

If you use a different method for distributing certificates in your organization, you can also use that
method. The following procedure is an example.

Let's assume you want to distribute the certificate to the client PCs using HCL Notes.

This is how it works

1. Open the Domino directory of your HCL Domino server on the client PC using HCL Notes or HCL
Domino Administrator.

2. Go to Security > Certificates and click Actions > Import Internet Certificates. The counter certifi-
cate is recognized by the server as a result of the import. To ensure that the certificate is also
recognized by the client PCs, you can distribute the counter certificate using group policies in HCL
Domino. You can use an existing policy or create a new one.

3. Go to People and Groups > Policies in HCL Domino Administrator to customize a particular group
policy.

4. Go to the Security area and select the existing security configuration under Security Settings.
5. Go to the Keys and Certificates tab and select the certificate created for the security configuration.
6. Navigate to Administrative Trust Defaults and enable Enforce to declare the certificate as trusted.
7. Go to Policy > Policy Assignment to distribute the modified policy to all d.velop documents users.
8. Add the users and groups that will use the certificate for d.velop documents.
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1.2.10. Installing updates for d.velop documents in HCL Notes
When you install an update using d.velop software manager, select the option Update installed products
in d.velop software manager. The configuration of the earlier version is retained.

If you want to update your version of d.velop documents in HCL Notes, please note the following:

• Plan the update within your organization.
• Familiarize yourself with the system requirements and update your system environment if necessary.
• Prepare the installation for d.velop documents.
• Familiarize yourself with the installation steps for the integration.
• When updating d.velop documents in HCL Notes, always update d.velop documents domino as well.
• After updating d.velop documents in HCL Notes, distribute the d.velop documents RCP plug-in using

the update site.

If you want to update the integration simply to install hotfixes, for example, you can run the setup
without changes. You need only the HCL Domino credentials (for administrators).

If you are already using a d.velop documents integration and want to install d.velop documents in
HCL Notes additionally, the steps in the installation wizard are not so different from those for a new
installation. You will be guided through the necessary steps.

1.2.11. Installing updates for version 1.18.0 when using HTTPS
You can specify that communication between the Groupware app and d.ecs http gateway is secured by
HTTPS. If you perform an update from version 1.18.0 to a higher version, the configuration is not fully
transferred automatically in this case.

You therefore have to adapt the configuration manually to ensure that the Groupware app works
correctly.

To do so, open the file conf/appsettings.json in the installation directory. The settings for the port and
protocol have been transferred from the previous installation automatically. Example:

{
  "port lower bound": "4205",
  "port upper bound": "4205",
  "protocol": "https"
}

Add the certificate to be used. Example:

{
  "port lower bound": "4205",
  "port upper bound": "4205",
  "protocol": "https",
  "Kestrel": {
    "Certificates": {
      "Default": {
        "Subject": "d3one1.dev.local",
        "Store": "My",
        "Location": "LocalMachine"
      }
    }
  }
}
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1.2.12. Uninstalling d.velop documents in HCL Notes
The software you installed using d.velop software manager can only be uninstalled with d.velop software
manager. If the software to be uninstalled has dependencies with other software packages, you must
resolve these conflicts accordingly.

For further information on uninstallation, see the d.velop software manager manual.

Before you uninstall d.velop documents on the server, you should first locally uninstall the d.velop
documents integration on the client PCs. This ensures that d.velop documents is not called by a client PC
even though the integration was already uninstalled on the server.

Once you have uninstalled all the components, you can start the uninstall program to uninstall d.velop
documents.

After uninstalling d.velop documents on the server, uninstall d.velop documents domino.

Uninstalling d.velop documents in HCL Notes locally
To uninstall d.velop documents in HCL Notes on the server, you must uninstall the integration locally on
the client PCs using the widget catalog.

This is how it works

1. Log into HCL Notes as an administrator.
2. In the HCL Domino Directory, open the form Desktop Settings in the view Policies\Settings.
3. Click Edit Settings to switch to editing mode.
4. Click the Widgets tab.
5. Under Widget Settings, select the widget category Widget catalog categories to install to remove

the integration.

For more information about uninstalling widget categories, see the HCL Domino Administrator Help.

You can then uninstall d.velop documents in HCL Notes with d.velop software manager.

Uninstalling d.velop documents domino
If you have uninstalled d.velop documents in HCL Notes locally on all client PCs and on the server
using the d.velop documents uninstaller, you must uninstall d.velop documents domino via the Windows
Control Panel. Uninstall d.velop documents domino on each HCL Domino server where the application is
installed.

This is how it works

1. Open the Windows Control Panel on the HCL Domino server where d.velop documents domino is
installed.

2. Select d.ecs domino from the list.
3. Select Uninstall to start the wizard and follow the steps.
4. Complete the uninstall with Finish.

Warning
If you select Delete configuration and certificates in the Configuration data step, the
d3oneconfg.nsf database in the data directory on the HCL Domino sever is deleted and
the configuration is lost. The certificate and Keystore specified during setup will also be
deleted.

If you want to reinstall d.velop documents domino at a later point in time, you have to recreate the
configuration, certificate and Keystore and, if required, distribute and sign them in the domain.
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1.2.13. Rolling back an installation of d.velop documents in HCL Notes
You can restore an earlier version of the software that you installed with d.velop software manager.
During this process, the software is only reset to a previous version.

For further information on rolling back to an earlier version, see the d.velop software manager manual.

1.2.14. Enabling the default port for d.velop documents in HCL Notes

• The port for the integration in d.velop documents is set to port 8182 by default.

1.3. Configuring d.velop documents in HCL Notes
This section provides you with information about configuring d.velop documents in HCL Notes and the
components required.

1.3.1. Establishing a connection between the d.velop documents application server
and d.velop documents domino
For d.velop documents in HCL Notes to function properly, you need to ensure communication between
the HCL Domino server, the client PCs running HCL Notes and the d.velop documents application server.
You can configure the connection data on the HCL Domino server where d.velop documents domino is
installed. You must be logged in with a Windows administrator account to configure the connection data.

Let's assume you want to configure the connection data on the HCL Domino server for communication
between the servers.

This is how it works

1. In the data directory, open the d3onecfg.nsf database using HCL Notes or a browser and navigate
to Settings. Make sure that the d3onecfg.nsf file is stored in the root directory of the databases. The
file must not be stored in a subdirectory.

2. On the d.3one server tab, enter the host name of the server where d.velop documents is installed
(base address). You have to enter the fully qualified domain name (FQDN) of the d.velop docu-
ments server in order for Kerberos authentication to work properly in the Windows domain, e.g.
d.3one.contoso.com.

3. Enter the port for the d.velop documents application server.
4. Go to the d.ecs domino tab and select the log level for d.velop documents domino under Log level.
5. Enter the path to the log file under Log path.
6. Enter the name of the log file under Log file.
7. Under Work path, enter the file path where the temporary files for d.velop documents domino are

stored (e.g. for converting e-mails). If you do not enter a path, the Temp system folder will be used.
8. Under SSL port, enter the port for the encrypted connection for d.velop documents domino. The

default port is 8182.
9. Go to the Certificate tab and enter the file path of the Java Keystore under Keystore file path. The

Java Keystore stores the key to be used for the secure connection.
10. Enter the password for the Java Keystore under Keystore password.
11. If necessary, enter the password for the key stored in the Java Keystore under Key password.

If your users retrieve their mail databases from different servers, you may need to replicate the database
on the mail servers so that your settings for d.velop documents on the server can also be used for the
client PCs running HCL Notes.

After you have set the connection data, you have to set the connection data in d.velop documents as
well.
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1.3.2. Defining the d.velop documents domino connection data in d.velop docu-
ments
If you have set the connection data for d.velop documents domino on the HCL Domino server, you
also have to set the connection data in d.velop documents for the connection between the d.velop
documents server and d.velop documents domino.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry IBM Domino under E-mail management.
3. Select Enable IBM Domino services.
4. Under d.ecs domino service server, enter the host name of the client PC where d.velop documents

domino is installed.
5. Under d.ecs domino service port, enter the port for d.velop documents domino. The default port is

8182.
6. Save your entries and restart the Groupware app.

1.3.3. Defining call parameters for DGI2EML
You can use the tool DGI2EML to specify various call parameters. You can also specify the parameters
when calling the program. The order is irrelevant. You specify the path to the DGIX file directly without
parameters.

The following parameters are available to you:

-silent

• Meaning: You use the parameter to specify that all the user interfaces are suppressed and only the
conversion of the DGIX file is performed.

• Value: true or false
• Default value: false
• Example: -silent=true

-temp

• Meaning: You use the parameter to define the directory in which the conversion is performed.
• Value: "<Path to the directory>"
• Default value: Temporary directory of Windows
• Example: -temp="C:\test"

Sample call: DGI2EML.exe "C:\E-Mail.dgix" -silent=true -temp="C:\temp"

See also:

• Installing the DGIX viewer
• Detailed information about how DGI2EML works

1.3.4. Defining call parameters for DGI2HTML
You can use the tool DGI2HTML to specify various call parameters. You can also specify the parameters
when calling the program. The order is irrelevant. You specify the path to the DGIX file directly without
parameters.

The following parameters are available to you:

-silent
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• Meaning: You use the parameter to specify that all the user interfaces are suppressed and only the
conversion of the DGIX file is performed.

• Value: true or false
• Default value: false
• Example: -silent=true

-temp

• Meaning: You use the parameter to define the directory in which the conversion is performed.
• Value: "<Path to the directory>"
• Default value: Temporary directory of Windows
• Example: -temp="C:\test"

-lang

• Meaning: You use this value to specify the language for the conversion.
• Value: "<Language>"
• Default value: Language of the operating system
• Example: -lang="en-US"

-renditionMode

• Meaning: You use this value to define a special page for the rendering (for example, to ensure that no
links are created for attachments).

• Value: true or false
• Default value: false
• Example: -renditionMode=true

-renderBccRecipient

• Meaning: You use this parameter to specify whether you want to display the BCC recipients.
• Value: true or false
• Default value: false
• Example: -renderBccRecipient=true

Sample call: DGI2HTML.exe "C:\E-Mail.dgix" -silent=true -temp="C:\temp" -lang="en-US" -rendition-
Mode=true

See also:

• Installing the DGIX viewer
• Detailed information about how DGI2HTML works

1.3.5. Configuring the Internet Explorer browser settings for viewing e-mail attach-
ments
To ensure that your users can also view e-mail attachments stored in the d.3 repository separately
in their e-mail application, you must configure settings in Internet Explorer. Internet Explorer is only
supported by the feed for d.3 8.1.0. The Current feed no longer supports Internet Explorer.

The changes in Internet Explorer are required because the attachments are no longer included in the
e-mail, but are now linked. It may not be possible to open the relevant e-mail with Internet Explorer
because the files cannot be saved.

We recommend distributing the settings using the group policies in the domain.

To ensure that your users can view attachments in Internet Explorer, you must allow encrypted pages to
be saved in Internet Explorer.
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This is how it works

1. In Internet Explorer, open Tools > Internet Options.
2. Go to the Advanced tab.
3. Go to Security and deactivate the option Do not save encrypted pages to disk.

1.3.6. Creating your own sources for mappings
Pre-configured sources for creating mappings are available to you as standard with the integrations and
d.ecs content crawler. However, you can also create your own sources with additional custom fields.

You do not need to define sources for journal archiving because you can use the applicable standard
source.

Note
If a source is being used for a configuration, you can no longer change or delete the
source.

Let's assume you want to define your own source for a mapping.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry Sources under E-mail management.
3. In the source overview, choose the context action Create new source.
4. Enter a unique name for the source.
5. Select the base source from which you want the source to obtain basic information.
6. If necessary, select Add or edit custom field to define additional custom fields for the source.
7. Enter the name of the custom field as the name appears in the source system.
8. Enter a display name for the custom field.
9. Under Type, select a file type for the custom field.
10. Click Add.

You can now add, edit and delete custom fields as required or save your entries to use the source for a
mapping.

See also:

• Detailed information about sources
• Example of the use of sources
• Detailed information about categories
• Detailed information about mappings

1.3.7. Creating your own categories for a mapping
You must define at least one category to create a mapping.

You do not need to define categories for journal archiving because you can use the applicable default
category.

Note
If a category is being used for a configuration, you cannot delete the category.

Let's assume you want to define your own category for a mapping.

This is how it works
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1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry Categories under E-mail management.
3. In the category overview, choose the context action Create new category.
4. Enter a unique name for the category and save your entries.

See also:

• Detailed information about categories
• Example of the use of categories
• Detailed information about sources
• Detailed information about mappings

1.3.8. Creating a "Store in" function
You can use a Store in function to help your users with their daily work. Define a d.3 repository and a
d.3 category in which your users can store items using the Store in context menu. When your users save
items, the repository and category are already selected.

Let's assume you want to create a new Store in function.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry 'Store in' functions under Context menus and functions.
3. Select the context action Create new 'Store in' function.
4. Enter a name for the function and add a description.
5. Select the repository that you want to be automatically selected for your users.
6. Select a source to be used to save the items.
7. Select the category that you want to be automatically selected for your users.
8. Enter a display name for the context menu for the required language.
9. If necessary, select a post-processing action that your users will see by default when saving.
10. If necessary, define the users or user groups that you want to see the context menu. If you want to

provide the Store in function for all users, leave the field empty.
11. Save your entries.

To ensure that your users can use the Store in function you created, you must restart the user e-mail
applications.

1.3.9. Creating a "Go to" function
You can use a Go to function to help your users with their daily work. Your users can then open e-mails
easily in a different application (e.g. an ERP system).

You can create a Go to function for any third-party provider application that can be accessed with a URL.

When you create the function, you can also define whether the other application is displayed in the
inbox on the sidebar or opened in a browser window, for example. Make sure that the relevant resource
can be integrated. If your resource prevents integration, select the option for displaying it in a separate
browser window.

Let's assume you want to create a new Go to function.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.
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2. Select the entry 'Go to' functions under Context menus and functions.
3. Then choose the context action Create new 'Go to' function.
4. Enter a name for the regular expression and add a description if necessary.
5. Under Menu entry, enter a display name for the context menu. If necessary, add the placeholder

<DOCVALUE> to the display name. The placeholder is filled with the result of the regular expres-
sion. If you want to use the result of the regular search, omit the placeholder.

6. Under Group for authorized users, you can define specific groups that you want to see the context
menu, if necessary. If you want to provide the Go to function for all users, leave the field empty.

7. Enter a regular expression for the search in the repository and, if necessary, click the pen icon to test
the regular expression. For example, if you use the regular expression D[0-9]{8}, a document ID such
as D00000191 is found and the result of the search is provided in the placeholder <DOCVALUE>.

8. Choose the elements for which the regular expression is to be used.
9. Under Open URL, enter the URL that you want to open for the result of the regular expression.

If necessary, add the placeholder <DOCVALUE> to the URL. Only one individual result from the
regular expression is ever used. You can also use a path to an application in the form of a URL.

10. Choose whether you want to display the Go to function in the sidebar or in a separate browser
window.

11. Save your entries.

To ensure that your users can use the Go to function you created, you must restart their e-mail applica-
tions.

See also:

• Example of use for opening e-mail content in web applications
• Example of use for searching for a document in d.3 smart explorer

1.3.10. Creating a "Move to folder" function
You can centrally define a folder to which items are directly moved when storing them in the d.3
repository.

Let's assume you have created the sub-folder Order confirmations for your users, so that order confir-
mations can be collected centrally in the mailbox. You want to enable your users to move e-mails directly
to the folder when storing them in the d.3 repository.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry Management options under E-mail management.
3. In the Groupware settings perspective, enable the option for moving items to specific folders.
4. Enter <file path>\Order confirmations under Folder path and save your entries.

In HCL Domino, the Move to folder function only moves e-mails from the inbox. E-mails from other
folders are linked to the specified folder.

1.3.11. Creating a "Search for" function
You can use a Search for function to help your users with their daily work. Your users can then quickly
and easily search for a search term within the context of an e-mail, for example to find the relevant
customer file directly in the d.3 repository.

You can also enable the fully automated context-sensitive search. When your users select an e-mail, the
search starts automatically after a short time (3 seconds). The automatic search is performed only if a
result is found for the regular expression. The search is not performed if a storage dialog is displayed.

Define a regular expression (RegEx) for the context-sensitive search. If the regular expression results in a
search term with more than 500 characters, only the first 500 characters are used for the search. You can
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truncate the view in the context menu to fewer than 500 characters by adding three periods (...) to the
menu entry.

Let's assume you want to create a new Search for function.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry 'Search for' functions under Context menus and functions.
3. Then choose the context action Create new 'Search for' function.
4. Enter a name for the regular expression and add a description if necessary.
5. Select the repository to be searched.
6. Select the d.3 categories to which the search is to be restricted. If you want to search in all

categories, leave the field empty.
7. Under Group for authorized users, you can define specific groups that you want to see the context

menu, if necessary. If you want to provide the Search for function for all users, leave the field empty.
8. Enter a regular expression for the search in the repository and, if necessary, click the pen icon to test

the regular expression. For example, if you use the regular expression D[0-9]{8}, a document ID such
as D00000191 is found and the result of the search is provided in the placeholder <DOCVALUE>.

9. Choose the e-mail elements for which the regular expression is to be used.
10. If necessary, activate the Automatic search option.
11. Under Menu entry, enter a display name for the context menu. If necessary, add the placeholder

<DOCVALUE> to the menu entry. The placeholder is filled with the result of the regular expression.
If you want to use the result of the regular search, omit the placeholder.

12. Save your entries.

To ensure that your users can use the Search for function you created, you must restart the user e-mail
applications.

See also:

• Example of use for searching for domains
• Example of use for searching in sender information

1.4. Tips and tricks
This topic provides you with useful tips on functions and tips for making your work easier.

1.4.1. Configuring the settings for accessing the d.velop documents in HCL Notes
administration with single sign-on
If you want to call the administration in the integration using single sign-on (SSO), you must configure
the appropriate settings in the internet options of your operating system (individually or with group
policies). You must add the d.velop documents base address in the internet options for the Local intranet
security zone.

This is how it works

1. Open the Windows control panel and select Internet Options.
2. Go to Security and select Local intranet.
3. Click Sites > Advanced.
4. Under Add this website to the zone, add the d.velop documents base address and choose Add to

confirm.

You can choose Custom level and go to User Authentication to define whether the login data is sent
from the client PC to the server (SSO) or whether the user is asked for his or her user name and
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password. Automatic log in only in Intranet zone is enabled by default, which means that single sign-on
should be enabled.

1.4.2. Assigning enhanced named user licenses for user groups
With the aid of user groups, you can specify which users can use all the functions of an integration and
which users are to receive only a basic license.

Let's assume you want to make all the functions of an integration available to a group of users.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry Management options under E-mail management.
3. In the Groupware settings perspective under Group for users with advanced license, select the

relevant user group.
4. Save your entries.

See also: Detailed information about the license-dependent scope of functions of the integration

1.4.3. Preparing the check for duplicates
You can avoid storing unnecessary duplicates in the d.3 repository using the Groupware app.

To ensure that the check for duplicates works properly, you must ensure that the items in the repository
are imported and stored with the appropriate d.3 status. For example, if you want to enable importing
and storing with a status when creating a mapping for the item E-mail, you must define the value No for
the following parameters in the d.3 admin configuration:

• IGNORE_DUPS_IN_A: For checking items that are stored directly with the status Archive.
• IGNORE_DUPS_IN_B_P: For checking items that are stored directly with the status Processing or
Verification.

For more information about the parameters and the check for duplicates, see the d.3 admin manual.

1.4.4. Enabling the check for duplicates
You can avoid storing unnecessary duplicates in the d.3 repository by enabling the check for duplicates in
the Groupware app.

The check for duplicates is also dependent on the document status in the d.3 administration. Therefore,
check the values for TEST_FOR_DUPLICATES, IGNORE_DUPS_IN_B_P, IGNORE_DUPS_IN_A and IG-
NORE_DUPS_IN_OTHER_DOCTYPES.

You can enable the function for d.velop documents and d.ecs content crawler.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry Management options under E-mail management.
3. In the Groupware settings perspective, select the option for checking for duplicates.
4. Save your entries.

1.4.5. Configuring a permission check
When you save e-mails in the d.3 repository, all the recipients and the sender of the e-mail are written
to a d.3 system field (dvelop.groupware.mail.restrictions). With d.3 server version 8, you have the option
of setting a permission check using restriction sets. Existing groups in the recipient list are retroactively
resolved.
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Note
If the X.500 address of internal recipients or the internal sender cannot be resolved,
an error message is written to the log. In addition, the d3 system field d.velop.group-
ware.mail.restrictions.resolve.error is filled with the value 1 to ensure that you can
identify and correct the affected document easily.

Furthermore, when saving from the e-mail application, the following values are written to d.3 system
fields and can be used for your permission check:

• dvelop.groupware.messageID: The message ID of the e-mail. The ID is also entered when saving
attachments.

• dvelop.groupware.attachmentid: The attachment ID when saving an individual attachment.
• dvelop.groupware.recoverableItem: If the saved document is based on an e-mail that is marked as

deleted in Microsoft Exchange, the value is 1.
• dvelop.groupware.attachments.count: The number of attachments is entered when saving an e-mail.
• d.velop.groupware.attachments.name: The file name for the attachment when an e-mail is saved.
• dvelop.groupware.attachments.extension: The file extension, including the period, for the attachment

when an e-mail has been saved.
• d.velop.groupware.attachments.index: The internal index of attachments when saving e-mails. Specify

the parameter if you want to create a retrieval link.
• dvelop.groupware.attachments.size: The file size of the attachments when saving the e-mail.
• dvelop.groupware.attachments.type: The display of the attachment type. If the value is EMBEDDED,

the attachment is embedded. If the value is FILE, the attachment is an attached file.
• dvelop.groupware.mail.restrictions: A table that contains all the recipients and the sender of the

e-mail (permission control).
• dvelop.groupware.cm.token: If the option dbs | case manager-data process is enabled in d.ecs content

crawler, the dbs | case manager token is entered.
• dvelop.groupware.mail.conversationid: The conversation ID (message header: Thread-Index).

The following system fields are written only if the check for duplicates is disabled.

• dvelop.groupware.exchange.mailbox.objectguid: The unique object GUID of the d.velop documents
user that saved the item in the d.3 repository.

• dvelop.groupware.exchange.mailbox.userguid: The unique object GUID of the mailbox user from d.ecs
identity provider.

• d.velop.groupware.exchange.mailbox.name: The name of the Microsoft Exchange mailbox where the
saved e-mail is located.

1.4.6. Defining the maximum age of documents to be saved locally in the Offline
Store
You can use the Offline Store to access stored e-mails whose attachments have been replaced by HTTP
links even without a connection to your d.velop documents or HCL Domino server.

E-mails are synchronized when HCL Notes starts and at intervals of 60 minutes as long as HCL Notes is
running. This period is fixed and cannot be changed.

When saving archived e-mails locally, you have the option to save only items that have not exceeded a
certain period of time. The date on which the items are received or sent is used to calculate the period.

Let's assume you want to use the Offline Store and set a maximum age for the documents to be stored
there.

This is how it works

1. Choose File > Preferences.
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2. In the User Preferences dialog box, select the entry d.3one.
3. Activate the Offline Store.
4. Enter the relevant value under Synchronize documents of the previous x days and confirm your

settings.

1.4.7. Adjusting the level of logging in the Groupware app
To identify the causes of errors, you can adjust the level of logging in the Groupware app to your
requirements.

Let's assume you want to specify that all messages are logged in the central d.3 log.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry Management options under E-mail management.
3. Go to the Logging perspective.
4. Under Log level, select the entry All. Save your entries.

See also: Detailed information about logging

1.4.8. Adjusting the settings for the cache
The cache is used to optimize the storage of items in the d.3 repository and to restore and display
e-mails, for example. You can adjust the cache settings to fit your needs. You can specify a cache
directory, a maximum cache size and the cache time.

Let's assume you want to increase the maximum cache size to 1500 MB and define the cache time as
one day.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry Management options under E-mail management.
3. Go to the Cache settings perspective.
4. Under Maximum cache size (MB), enter the value 1500.
5. Under Cache time in minutes, enter the value 1440.

1.4.9. Configuring the web server settings for link resolution of d.link for lotus
notes attachments
In the Groupware app, you can configure the web server to define how d.link for lotus notes attachments
are converted to links.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry IBM Domino under E-mail management.
3. Enable Resolve d.link for lotus notes attachments via HTTP.
4. Enter the port of the web server.
5. Enter the name, domain and password for the domain user that has the right to export the relevant

e-mails.
6. Save your changes and restart the Groupware app.

The repository ID is then automatically determined from the d.3 repository ID when the links are
resolved.
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If you have configured multiple repositories that use the same d.3 repository ID, you can map a d.3
repository ID to a repository ID if necessary.

1.4.10. Preventing encrypted documents from being stored
If necessary, you can prevent your users from storing encrypted documents in the d.3 repository.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry IBM Domino under E-mail management.
3. Enable Do not store encrypted documents.
4. Save your entries.

When attempting to store encrypted documents, your users will now receive a message and the storing
process will be terminated.

1.5. Frequently asked questions
In this section, you can find answers to frequently asked questions.

1.5.1. Why am I asked for cross-certification the first time I open a folder created
with the "Move to folder" function in HCL Domino?
The first time you open a folder defined with the Move to folder function, HCL Domino may prompt you
for cross-certification. Make sure that cross-certification is permitted in this case.

1.5.2. What do the different log levels mean when configuring the connection data
for d.velop documents domino?
When you configure the connection data on the HCL Domino server for communication between the
HCL Domino server, the client PCs running HCL Notes and the d.velop documents application server,
you have to set the log level for d.velop documents domino. The following log levels are available under
Log level:

• Off: logging is disabled. Only serious errors are logged.
• Info: only additional information is logged.
• Warning: only warnings are logged.
• Fine: warnings and other messages are logged.
• Finer: Warnings are logged, along with more messages than for log level Fine.
• Finest: Warnings are logged, along with more messages than for log level Finer.
• All: everything is logged.

If errors have occurred, you must set the log level to All. Quit the d.velop documents domino service and
restart it. Recreate the error and provide all log files to d.velop support.

See also: Applying setting changes for d.velop documents domino

1.5.3. What is a named user license?
A named user license is used to assign a dedicated user to a product or an integration. Due to this
assignment, a license is reserved for one user and the license cannot be used by any other user.

The first time that each d.velop documents integration is started, named user licences are assigned for
the user and the d.velop documents integration. For example, if a user logs into d.velop documents in the
browser or integration, a license is reserved for this user and for this product in d.ecs license server.

See also: Detailed information about d.velop documents licenses
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1.5.4. What can I do if the display of DGIX files as HTML pages does not work
properly?
An incorrect data extension causes problems displaying DGIX files. If an image has the file extension for
bitmaps (*.bmp), for example, but is actually a JPEG file (*.jpg), the image is not displayed.

The DGIX viewer (DGI2HTML) uses Internet Explorer embedded on the client PC to display the DGIX
file as an HTML page. Internet Explorer (embedded) displays an error when displaying local images
because the images have the incorrect file extension.

In this case, you can display DGIX files using the DGI2EML viewer instead of the DGI2HTML viewer.

1.5.5. What are categories?
You can help your users with their daily work by defining categories for storing items. By default, there
are no predefined categories. However, you can create your own categories in the administration.

You can classify sources (e.g. e-mails or attachments) for storage in the repository using d.3 categories
(document types). Furthermore, you can also use the Groupware app to define your own categories in
which items are stored. You can use a category to map a source to multiple d.3 categories.

You can customize the categories, because the categories are independent of the repository and the
source.

See also:

• Creating categories
• Detailed information about sources
• Detailed information about mappings

1.5.6. What are sources?
Mappings let you link any source system (e.g. an e-mail application or ERP system) with a d.3 repository.

A source system can specify multiple sources, such as e-mails and attachments. The sources describe an
item with specific properties and categories in the source system.

In the context of the Groupware app, sources are items to be processed, such as e-mails or attachments.
The app identifies the properties of the source (e.g. sender, subject or recipient) and generates the
document file to be stored.

You can use a mapping to link the properties of a source with specific d.3 property fields (repository
fields). You can define your own sources for mappings.

You can also further classify the sources by creating categories. The categories are independent of the
categories (document types) in the d.3 repository.

The e-mail integrations and d.ecs content crawler provide you with default sources for creating map-
pings:

• Standard - Microsoft Exchange e-mail
• Standard - Microsoft Exchange attachment
• Standard - Microsoft Exchange journal e-mail
• Standard - IBM Notes e-mail
• Standard - IBM Notes attachment
• Standard - IBM Notes journal e-mail
• Standard - appointment/meeting

See also:
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• Creating sources
• Detailed information about categories
• Detailed information about mappings

1.5.7. What are mappings?
A mapping lets you link a source system (e.g. an e-mail application) with a destination (a d.3 repository).

Each e-mail has certain standard properties, such as the sender, recipient or subject. You can map the
standard properties to a d.3 category and the appropriate d.3 properties. If you create appropriate
mappings, your users no longer have to specify these properties manually.

You can find additional information about creating and managing mappings in the d.3one administration
manual.

See also:

• Detailed information about sources
• Creating sources
• Detailed information about categories
• Creating categories

1.5.8. Which commands can I use in the HCL Domino console for d.velop docu-
ments domino?
If you have installed and started a recent version of d.velop documents domino, you can run the
following commands in the HCL Domino console for d.velop documents domino:

• load http: load the HTTP task of the HCL Domino server
• tell http quit: quit the HTTP task of the HCL Domino server
• tell http osgi ss com.dvelop.smartones.service: show the status of d.velop documents domino
• tell http osgi start com.dvelop.smartnotes.service: start d.velop documents domino
• tell http osgi stop com.dvelop.smartnotes.service: quit d.velop documents domino

1.5.9. Which field names are mapped to which source properties?
In this list, you can find information about the source properties for creating mappings. You can use
the list to see which source properties are mapped to which field names in Microsoft Outlook and HCL
Notes.

All recipient names (To, Cc and Bcc)

• HCL Notes: Calculated value
• Microsoft Outlook: Calculated value
• Meaning: List of all recipients (To, CC and BCC) as display names (if available)

All recipient SMTP addresses (To, Cc and Bcc)

• HCL Notes: Calculated value
• Microsoft Outlook: RecipientTable
• Meaning: List of all recipients (To, CC and BCC) as e-mail addresses (if available). If the online e-mail

address is unavailable in the Domino Directory, the value from the e-mail is used.

Unresolved recipient names (To, Cc)

• HCL Notes: Calculated value
• Microsoft Outlook: Calculated value
• Meaning: List of all unresolved recipient names (To, Cc)

Text body
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• HCL Notes: Body
• Microsoft Outlook: PR-BODY
• Meaning: Defined text content from the e-mail content. In unencrypted e-mails, the text content

cannot be read and is therefore transmitted as empty. In unencrypted e-mails, the text cannot be read.
As a result, mapping always results in an empty value.

Created on

• HCL Notes: Created document property
• Microsoft Outlook: PR_CREATION_TIME
• Meaning: Date that the e-mail was created

Received on

• HCL Notes: DeliveredDate
• Microsoft Outlook: PR_MESSAGE_DELIVERY_TIME
• Meaning: Date that the e-mail was delivered

Last modification time

• HCL Notes: $Revisions
• Microsoft Outlook: PR_LAST_MODIFICATION_TIME
• Meaning: Date that the e-mail was last changed

Message ID

• HCL Notes: $MessageID
• Microsoft Outlook: PR_INTERNET_MESSAGE_ID
• Meaning: Unique message ID for the e-mail

Message size in bytes

• HCL Notes: Calculated value
• Microsoft Outlook: Size
• Meaning: Size of the e-mail

Recipient names

• HCL Notes: SendTo
• Microsoft Outlook: Calculated value
• Meaning: List of the recipients as display names (if available)

Recipients’ SMTP addresses

• HCL Notes: SendTo
• Microsoft Outlook: Calculated value
• Meaning: List of the recipients as e-mail addresses

Recipients' SMTP addresses from message header

• Microsoft Outlook: Calculated value
• Meaning: List of the recipients as e-mail addresses, taken from the message header

Recipient names (Bcc)

• HCL Notes: BlindCopyTo
• Microsoft Outlook: RecipientTable
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• Meaning: List of the blind copy recipients as display names (if available)

Recipients' SMTP addresses (Cc)

• HCL Notes: CopyTo
• Microsoft Outlook: RecipientTable
• Meaning: List of the copy recipients as e-mail addresses

Recipients' SMTP addresses (Cc) from message header

• Microsoft Outlook: Calculated value
• Meaning: List of copy recipients as e-mail addresses, taken from the message header

All SMTP addresses (From, To, Cc and Bcc)

• HCL Notes: Calculated value
• Microsoft Outlook: RecipientTable
• Meaning: List of all SMTP addresses

Sender name

• HCL Notes: From
• Microsoft Outlook: PR_SENDER_NAME
• Meaning: Name of the sender

SMTP address of the sender

• HCL Notes: From
• Microsoft Outlook: PR_SENDER_EMAIL_ADDRESS
• Meaning: SMTP address of the sender

Senders' SMTP address from message header

• Microsoft Outlook: Calculated value
• Meaning: SMTP address of the sender, extracted from the message header

Subject

• HCL Notes: Subject
• Microsoft Outlook: PR_SUBJECT
• Meaning: Subject line of the e-mail

Sent on

• HCL Notes: PostedDate
• Microsoft Outlook: PR_CLIENT_SUBMIT_TIME
• Meaning: Date that the e-mail was sent

Number of attachments

• HCL Notes: Calculated value
• Microsoft Outlook: Calculated value
• Meaning: Number of attachments

Sent on behalf of (SMTP address)

• Microsoft Outlook: PR_RCVD_REPRESENTING
• Meaning: SMTP address of the deputy sender

d.velop documents in HCL Notes

34



Sent on behalf of (name)

• Microsoft Outlook: PR_RECEIVED_BY
• Meaning: Name of the deputy sender

Time (received/sent on/created)

• HCL Notes: Calculated value
• Microsoft Outlook: Calculated value
• Meaning: Delivery date (if available). If the delivery date is unavailable, either the submission date

(Submit) or creation date (Create) is used. The creation date is always available.

Mailbox ID

• Microsoft Outlook: MBADGUID
• Meaning: Mailbox ID in the Active Directory. The mailbox ID can be used to control authorization, for

example.

Mailbox name

• Microsoft Outlook: Calculated value
• Meaning: Name of the Microsoft Exchange mailbox (the SMTP address by default)

Folder name (last level)

• HCL Notes: Calculated value
• Microsoft Outlook: Calculated value
• Meaning: Folder containing the e-mail. With HCL Notes e-mails, the folder path can be determined

only if the folder references in the mail database have been activated and the e-mail has been
received or moved following the activation. Do not use backslashes (\) when mapping folder names.
Backslashes are required to map Folder path (split).

Folder path

• HCL Notes: $FolderRefs
• Microsoft Outlook: PR_FOLDER_PATH
• Meaning: Complete path of the folder containing the e-mail.

Folder path (split)

• HCL Notes: Calculated value
• Microsoft Outlook: Calculated value
• Meaning: List of folders containing the e-mail, calculated from the folder path.

Category

• Microsoft Outlook: PidNameKeywords
• Meaning: Name of the Outlook category

For attachments:

File name

• HCL Notes: Calculated value
• Microsoft Outlook: PR_ATTACH_FILENAME
• Meaning: Original file name of the attachment

File index
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• HCL Notes: Calculated value
• Microsoft Outlook: PR_ATTACH_NUM
• Meaning: Index of the attachment

File size in bytes

• HCL Notes: Calculated value
• Microsoft Outlook: PR_ATTACH_SIZE
• Meaning: Size of the file in bytes

File extension

• HCL Notes: Calculated value
• Microsoft Outlook: PR_ATTACH_EXTENSION
• Meaning: The file extension

For user information, you can select the login name of the Windows user that is assigned to the mailbox
using the Mailbox SAM account name display name. The SAM account name can be identified only if
you have configured an Active Directory in d.ecs identity provider. Furthermore, you must specify a user
with the SMTP address of the mailbox, which is not always possible with Microsoft Office 365.

1.5.10. Which languages can I use as call parameters for the DGI2HTML viewer?
If you want to specify a call parameter for the DGI2HTML viewer, the following languages with the
following values are available to you:

• English: en-US
• German: de-DE
• Czech: cs-CZ
• Danish: da-DK
• Spanish: es-ES
• French: fr-FR
• Croatian: hr-HR
• Italian: it-IT
• Dutch: nl-NL
• Polish: pl-PL
• Serbian: sr-Cyrl

1.5.11. How do I enable the post-processing options?
When storing items in the d.3 repository, your users can use the post-processing options to replace
attachments in the mailbox with HTTP links, for example, or to select the folder to which the items are to
be moved.

The post-processing options are enabled by default. If an option is not automatically enabled, you can
enable the option later.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry Management options under E-mail management.
3. Select Enable post-processing.
4. Save your entries.
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1.5.12. How do I change the settings for the "Send and store" function?
You can use the Send and store function to help your users with their daily work. The function lets your
users send e-mails and attachments while storing them in a suitable category in the d.3 repository at the
same time.

The function is available only for the primary mailbox in Microsoft Outlook. The sent items must be
stored in the Sent Items folder in Microsoft Outlook.

The function is enabled by default. Where necessary, they can change the source and category for the
function or use the context actions to create new sources and categories directly.

Let's assume you want to change the source and category for the Send and store function.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry 'Send and store' functions under Context menus and functions.
3. Select a source.
4. Select a category and save your entries.

To ensure that your users can use the modified Send and store function, you must restart their e-mail
applications.

1.5.13. How do I create a "Go to" function for opening e-mail content in web
applications? (Example of use)
You can use a Go to function to map different scenarios (for example, for opening the content of e-mails
in third-party provider applications) using URLs.

Example

You want to enable your users to open e-mail content for customer numbers (e.g. KN00451) in an
internal CRM application.

To make this function available to your users, you can create a Go to function. Under Open URL, enter a
URL template for the internal CRM application (e.g. https://crm.company.com/customer/) as the URL.

When the specified URL is subsequently accessed, https://crm.company.com/KN00451 is then retrieved
as the result of the search and opened as a URL in your users' web browser.

See also:

• Creating Go to functions
• Creating Go to functions for searching for documents in d.3 smart explorer (example of use)

1.5.14. How do I create a "Go to" function for searching for a document in d.3
smart explorer? (Example of use)
You can use a Go to function to map different scenarios (for example, for searching for a document in
d.3 smart explorer) using URLs. In this case, you must ensure that d.3 smart explorer is installed on your
users' client PCs.

Example

You want to enable your users to search for specific document IDs (e.g. D00000191) in d.3 smart
explorer. The result of the search is stored in the placeholder <DOCVALUE>.

To make this function available to your users, you can create a Go to function. Under Open URL, enter
d3://d3explorer/idlist=<DOCVALUE> as the URL.
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When the specified URL is subsequently called, d3://d3explorer/idlist=D00000191 is then retrieved as
the result of the search. This URL is used to start d.3 smart explorer on your users' client PCs and
perform a search for the document ID.

See also:

• Creating Go to functions
• Creating Go to functions for opening e-mail content in web applications (example of use)

1.5.15. How do I create a "Search for" function to search the domain? (Example of
use)
With a Search for function, you can use a regular expression to specify that a domain is read for the
search.

Example

To read the relevant domain, enter the following regular expression while creating a Search for function:
@[a-z.-]+\.[a-z]{2,}

When the search is then performed, the regular expression finds the domain.

See also:

• Creating Search for functions
• Creating Search for functions for sender information (example of use)

1.5.16. How do I create a "Search for" function for searching in sender informa-
tion? (Example of use)
With a Search for function, you can use a regular expression to specify that the search term is read out
from the sender information.

Example

You want to specify that the SMTP address is also read during the search.

To extend the search to the SMTP address, enter the following regular expression while creating a
Search for function: [a-z0-9\-_]?[a-z0-9.\-_]+[a-z0-9\-_]?@[a-z.-]+\.[a-z]{2,}

When the search is then performed, the regular expression finds the relevant SMTP address.

See also:

• Creating Search for functions
• Creating Search for functions for domains (example of use)

1.5.17. How does DGI2EML work?
You can use the DGI2EML tool to display DGIX files in your e-mail application. The EML format is
a standardized format for displaying e-mails and is supported by many e-mail applications, such as
Microsoft Outlook and HCL Notes.

The tool creates a temporary EML file from the DGIX file. The temporary EML file is used for the display
in the e-mail application. When the DGIX file is opened, the e-mail application starts and displays the
e-mail as usual. Your users can edit, send or forward e-mails as usual.

Aspects to note

• Encrypted or signed e-mails may be displayed differently from their originals.
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• If you respond to a temporarily restored e-mail or forward this e-mail, this information is not written to
the archived document.

See also:

• Installing the DGIX viewer
• Defining call parameters for DGI2EML

1.5.18. How does DGI2HTML work?
You can use the DGI2HTML tool installed on the client side to display DGIX files on your system. The
tool enables a view that is independent of d.velop documents.

The tool temporarily creates an HTML file based on the DGIX file. The temporary HTML file is used for
displaying in DGI2HTML.

Displaying signed e-mails 

You can identify a signed e-mail by the signature symbol . The signature is not checked.

Displaying encrypted e-mails 

You can identify an encrypted e-mail by the lock symbol . The text body of an encrypted e-mail cannot
be displayed with the DGI2HTML viewer.

Aspects to note 

• Although you can use the DGI2HTML viewer to display stored e-mails and attachments, you cannot
edit or forward the e-mails.

• Encrypted or signed e-mails may be displayed differently from their originals.

See also:

• Installing the DGIX viewer 
• Defining call parameters for DGI2HTML 

1.5.19. How can I apply setting changes for d.velop documents domino?
If you make changes to the settings of the d.velop documents domino service in the d3onecfg.nsf file,
you have to restart the d.velop documents domino service afterward.

The d.velop documents domino service is automatically restarted when you restart the HCL Domino
service.

If you want to restart the d.velop documents domino service manually, enter the following commands in
the HCL Domino server console:

• tell http osgi stop com.dvelop.smartnotes.service
• tell http osgi start com.dvelop.smartnotes.service

1.5.20. How do I check for duplicates of encrypted e-mails?
A check for duplicates is not performed for encrypted e-mails.

1.5.21. How do I configure d.velop documents domino to start automatically?
When you restart the HCL Domino server, you must also always restart d.velop documents domino. You
can set d.velop documents domino to restart automatically.

This is how it works
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1. In Domino Administrator, open the file Names.nsf.
2. Open Configuration > Servers > Programs and choose Add Program.
3. Under Program name, enter nserver.
4. Under Command line, enter -c "tell http osgi start com.dvelop.smartnotes.service".
5. Under Server to run on, specify the name of your HCL Domino server.
6. Under Enabled/disabled, select the entry At server startup only.

1.5.22. How can I use categories to create mappings for specific customer scenar-
ios? (Example of use)
You can define your own categories to create specific mappings for your organization.

Example

An employee receives a variety of different e-mails. One part of these e-mails is correspondence for
purchasing. The other part of these e-mails is correspondence for sales. The categories (document types)
CorrPurchase and CorrSales are available in the d.3 repository.

The Department property must be defined based on the e-mail type (purchasing or sales). However, only
the employee can decide which type of e-mail it is. Nevertheless, when storing e-mails, the employee
should only have to change the storage form in a small number of exceptional cases. In the ideal
scenario, the employee stores the e-mails directly in the repository so that the relevant processes can be
started within the organization.

The administrator for the organization defines two new categories in the Groupware app configuration:
Purchasing correspondence and Sales correspondence.

The administrator uses one of the default sources as the source.

The administrator creates two new Store in functions in the Groupware app configuration. For one
function, the administrator selects the newly created category for the correspondence for purchasing.
For the other function, the administrator selects the newly created category for the correspondence for
sales.

Two new context menus for storing items in the d.3 repository are then available to the employee. With
the aid of the context menus, the employee can directly decide whether an e-mail is to be stored for
Sales or Purchasing.

See also:

• Detailed information about categories
• Creating categories
• Detailed information about sources
• Creating sources
• Detailed information about mappings

1.5.23. How can I use sources to create mappings for specific customer scenarios?
(Example of use)
You can define your own sources to create specific mappings for your organization.

Example

An employee receives a variety of different e-mails. One part of these e-mails is correspondence for
purchasing. The other part of these e-mails is correspondence for sales. However, only the category
(document type) Correspondence is available in the d.3 repository.

The Department property must be defined based on the e-mail type (purchasing or sales). However, only
the employee can decide which type of e-mail it is. Nevertheless, when storing e-mails, the employee
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should only have to change the storage form in a small number of exceptional cases. In the ideal
scenario, the employee stores the e-mails directly in the repository so that the relevant processes can be
started within the organization.

The administrator for the organization defines two new sources in the Groupware app configuration:
Purchasing correspondence and Sales correspondence.

The administrator defines two new mappings for the two sources. Most of the source and target
properties in the mapping table are the same. For the Department property, the administrator provides
the value PUR in the mapping for the Purchasing correspondence source. In the mapping for the Sales
correspondence source, the administrator enters the value SALES for the Department property.

The administrator creates two new Store in functions. For one function, the administrator selects the
newly created Purchasing correspondence source. For the other function, the administrator selects the
newly created Sales correspondence source.

Two new context menus for storing e-mails in the d.3 repository are then available to the employee.
With the aid of the context menus, the employee can directly decide whether an e-mail is to be stored
for Sales or Purchasing.

See also:

• Detailed information about sources
• Creating sources
• Detailed information about categories
• Creating categories
• Detailed information about mappings

1.5.24. How can I restore stubs for d.link for lotus notes?
With d.velop documents in HCL Notes, you can temporarily restore d.link for lotus notes stubs without
using a d.link for lotus notes server or having d.link for lotus notes installed. In this scenario, d.velop
documents domino assumes the function of the d.link for lotus notes server.

If you are using d.velop documents domino, you must have the latest version of the Groupware app
installed. You must also make sure that the HCL Domino server is available as an HTTP server in the
d.velop documents domain. There is no need to integrate the HCL Domino server in the HCL Domino
domain.

If you want to temporarily restore d.link for lotus notes stubs, you need to install d.velop documents
domino on an HCL Domino server, create a conversion database and link the HCL Domino server to
d.velop documents domino.

This is how it works

1. Install the d.velop documents domino setup on a dedicated 64-bit HCL Domino server. The instal-
lation removes the previous version of d.velop documents domino and the related entries in the
notes.ini file on the HCL Domino server.

2. Create a conversion database with the exact file name nzipToDgix.nsf from a standard mail template
below the HCL Domino data directory.

3. Open the following address in a browser and enter the fully qualified name of your d.velop docu-
ments gateway: https://<d.velop documents gateway>/convertmail/settings

4. Enter the fully qualified address and port (by default 8182) of d.velop documents domino on the
HCL Domino server as follows: https://<HCL Domino server>:<port>

The repository ID is then automatically determined from the d.3 repository ID when the stubs are
resolved. If you have configured multiple repositories with the same d.3 repository ID, you must create a
fixed mapping for a d.3 repository ID and a repository ID.

d.velop documents in HCL Notes

41



See also: Mapping a d.3 repository ID to a repository ID

1.5.25. How do I enter my own conversion database for restoring d.link for lotus
notes stubs?
If you want to use a conversion database other than the default database for the temporary recovery
of d.link for lotus notes stubs, you have to manually adjust the conversion database assignment in
the notes.ini file of the HCL Domino server. Add the entry nzipToDgixDatabase=nzipToDgix.nsf to the
notes.ini file. Enter the file name of the conversion database relative to the HCL Domino data directory.

To save space in the conversion database, disable recoverable deletion for the database. We also recom-
mend that you regularly compress the database.

1.5.26. How do I map a d.3 repository ID to a repository ID?
If you have configured multiple repositories that have the same d.3 repository ID, you can map a d.3
repository ID to a repository ID in the Groupware app if necessary.

This is how it works

1. Open the Configuration feature from the start page and navigate to E-mails in the Document
management category.

2. Select the entry Management options under E-mail management.
3. Go to the Repository mapping perspective.
4. Enter the relevant d.3 repository ID.
5. Select the repository ID that you want to map to the d.3 repository ID.
6. Click Add and save your entries.

1.5.27. How do I show a newly created folder for the "Move to Folder" function if
the folder is not displayed in the view?
If you created a Move to folder function for a folder, the folder may not appear in the view. If this is the
case, close the mail database and reopen the database to refresh the view. Refreshing the view in HCL
Notes, e.g. with F9, is not sufficient.

1.5.28. What is the purpose of logging?
For logging, the d.velop documents integration writes to the central d.3 log. If an error occurs, all the
necessary information is logged so that the cause of the error can be identified quickly.

By default, the integration only logs errors. If you require more information, you can adjust the logging
level to your requirements.

See also: Adjusting the level of logging in the Groupware app

1.6. Additional information sources and imprint
If you want to deepen your knowledge of d.velop software, visit the d.velop academy digital learning
platform at https://dvelopacademy.keelearning.de/.

Our E-learning modules let you develop a more in-depth knowledge and specialist expertise at your own
speed. A huge number of E-learning modules are free for you to access without registering beforehand.

Visit our Knowledge Base on the d.velop service portal. In the Knowledge Base, you can find all our
latest solutions, answers to frequently asked questions and how-to topics for specific tasks. You can find
the Knowledge Base at the following address: https://kb.d-velop.de/

Find the central imprint at https://www.d-velop.com/imprint.
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